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Important Regulatory and Safety Notices

Before using this product and any associated equipment, refer to the symbols listed below so as to
avoid personnel injury and to prevent product damage.

Products may require specific equipment, and/or installation procedures be carried out to satisfy
certain regulatory compliance requirements. Notices have been included in this publication to call
attention to these specific requirements.

Symbol Meanings

ESD
Susceptibility

This symbol on the equipment refers you to important operating and maintenance
(servicing) instructions within the Product Manual Documentation. Failure to heed
this information may present a major risk of damage or injury to persons or
equipment.

The symbol with the word “Warning” within the equipment manual indicates a
potentially hazardous situation which, if not avoided, could result in death or serious

injury.

The symbol with the word “Caution” within the equipment manual indicates a
potentially hazardous situation which, if not avoided, may result in minor or
moderate injury. It may also be used to alert against unsafe practices.

The symbol with the word “Netice” within the equipment manual indicates a
situation which, if not avoided, may result in major or minor equipment damage or a
situation which could place the equipment in a non-compliant operating state.

This symbol is used to alert you that an electrical, or electronic device, or assembly
is susceptible to damage from an Electrostatic Discharge event.



Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its
production. It may contain hazardous substances that could impact health and the
environment.

To avoid the potential release of those substances into the environment and to diminish the need for
the extraction of natural resources, Ross Video encourages you to use the appropriate take-back
systems. These systems will reuse or recycle most of the materials from your end-of-life equipment
in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your
local or regional waste administration.

You can also contact Ross Video for more information on the environmental performances of our
products.
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Introduction

In This Chapter

This chapter contains the following sections:
e A Word of Thanks
e  Overview
e Features

e Documentation Terms and Conventions

A Word of Thanks

Congratulations on choosing the DashBoard Control System. DashBoard is part of a full line of
Digital Products within the openGear Terminal Equipment family of products, backed by Ross
Video’s experience in engineering and design expertise since 1974.

You will be pleased at how DashBoard fits into your overall working environment. Equally pleasing
is the product quality, reliability and functionality. Thank you for joining the group of worldwide
satisfied Ross Video customers!

Should you have a question pertaining to the installation or operation of DashBoard, please contact
us at the numbers listed on the back cover of this manual. Our technical support staff is always
available for consultation, training, or service.

Overview

The DFR-8300 series frames offers remote control and monitoring with the combination of the
openGear Network Interface card and the DashBoard Control System. This allows users to remotely
monitor and control parameters on openGear devices that support remote control.

The DashBoard Control System is built on Ethernet and TCP/IP technology, which allows remote
access across both LAN and WAN architectures. DashBoard is unique, as it operates under a well-
defined protocol, which is available to all openGear partners.

Monitoring

A network of openGear frames and cards can be monitored, allowing users to quickly isolate and
correct potential problems from a central monitoring station.
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Control

DashBoard offers real-time control of openGear card parameters. Parameter types vary depending on
card functionality.

Software Upgrades

Most openGear cards can be upgraded, both software and firmware, in the field using DashBoard.
The upgrade utility verifies firmware and software upgrades against card hardware in the frame and
prevents accidental loading of incorrect files to the wrong hardware.

Features

The following features make the DashBoard Control System a unique system for your openGear
requirements:

DashBoard is available for download from the Ross Video website

Customizable views with the installation of the Advanced Tree View licensed feature
Java based for installation in Microsoft Windows®

Multiple openGear frames can be connected to multiple DashBoard stations

Auto discovery of openGear frames and openGear cards on the same subnet

Software and firmware upgrades via ethernet

Documentation Terms and Conventions

The following terms and conventions are used throughout this manual:

“Frame” refers to any openGear frame within your video system.

All references to the DFR-8310 also include the DFR-8310-C versions with the cooling fan
option. See the respective User Manuals for details.

“Operator” and “User” refer to the person who uses DashBoard.

“Board”, and “Card” refer to openGear terminal devices within openGear frames,
including all components and switches.

“System” and “Video system” refer to the mix of interconnected production and terminal
equipment in your environment.

“Device” refers to an openGear frame or card listed in the DashBoard Control System
interface.

“Tree View” refers to both the Basic Tree and Advanced Tree Views unless otherwise
noted.

Navigation procedures in this manual state the menu items you are to select followed by the
“=” symbol.

The “Operating Tips” and “Note” boxes are used throughout this manual to provide
additional user information.

1-2 ¢ Introduction
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Installing DashBoard

In This Chapter

This chapter provides instructions for installing the DashBoard Control System software.
The following topics are discussed:
o Installing DashBoard Control System Software

e Activating DashBoard Licensed Features
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Installing DashBoard Control System Software

This section includes instructions on installing the DashBoard software to your computer.

Important If you are upgrading your DashBoard Control System to software version
2.0, or higher, the Install Wizard automatically uninstalls any previous
software versions before proceeding. Ensure that you have created a backup
of your setup before installing a new version of DashBoard.

Before Installation

Before installing any software for your DashBoard Control System, ensure that you have exited all
other programs currently running on the computer you are installing DashBoard on.

Installing DashBoard Control System Software

Use the following procedure to install your DashBoard Control System software:

1. Load the DashBoard software CD into the DVD/CD ROM tray of your computer.

Operating Tip The DashBoard Control System Software and User Manual can also be
downloaded from the Ross Video website.

2. If you are using a computer running Windows®, the Installation Wizard automatically
runs. You can also install the DashBoard program as follows:

e Navigate to your DVD/CD ROM drive in the Navigation Pane, so that the CD
contents are displayed in the Main Window of Windows Explorer.

o Select DashBoard2_setup.exe to begin installing the DashBoard program onto
your computer.

e  Follow the prompts to complete the install DashBoard onto your system.

This completes the procedure for installing your DashBoard Control System software.

Note You can uninstall the DashBoard Control System using the Uninstall
option in the DashBoard folder. Once the Uninstall Wizard has completed,
you must manually delete the Workspace folder from the C:\Programs
Files\DashBoard directory.
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Activating DashBoard Licensed Features

This section outlines how to install software keys to access DashBoard features such as the
Advanced Tree View. The required DashBoard software licenses must be purchased from your Ross
Video sales representative before activating DashBoard licensed features.

Activating DashBoard Licensed Features

This section outlines how to activate the DashBoard software licenses that you have purchased.

Use the following procedure to install a software license for a DashBoard feature:

1.
2.

9.

Launch the DashBoard software by selecting the DashBoard icon on your desktop.
Select the feature you want to install a software license for as follows:

e  From the main DashBoard toolbar, select Window = Preferences...

e From the Preferences dialog box, select Licensed Features.

A list of available licenses is displayed in the Licensed Features dialog box and is
organized into subfolders. The Active subfolder includes those features currently
installed on your computer. The Available subfolder lists the new features you can
install on your computer.

e From the Available subfolder, click the feature to install. The general and license
details of the selected feature is displayed in the Licensed Features dialog box.

From the Licensed Features dialog box, click Install/Update License to open the Enter
License Key dialog box.

The Enter License Key dialog box includes your Request Code, Hardware ID, and
Feature ID details. You need this information when contacting Ross Video Technical
Support. You can also print the information in the dialog box by pressing Print.

Contact Ross Video Technical Support using the information found in the “Contact Us”
section of this manual. Ensure that you have the following information from the Enter
License Key dialog box:

e Request Code
e Hardware ID
e Feature ID

When you speak to our Technical Support representative, tell them your name, your facility
name, and the Request Code as listed on the Enter License Key dialog box.

You will be given a License Key that must be entered in the License Key field of the Enter
License Key dialog box.

Enter the License Key in the License Key field.
Press Install to begin installing the key for the DashBoard software license.
When the installation is complete, the License Installed dialog box opens.

Press OK.

This completes the procedure for installing a software license for a DashBoard feature. For
information on updating installed licensed features, refer to the section “Updating DashBoard
Licensed Features” of this manual.
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Managing openGear Frames in
DashBoard

In This Chapter

This chapter provides instructions for controlling openGear frames in the DashBoard Control
System. DashBoard connects to an openGear frame using a TCP/IP LAN connection. Refer to the
user manual for your openGear frame, or your facility manager, for details on setting up your frame.

The following topics are discussed:
e Managing openGear Frames in DashBoard
e Configuring openGear Frames

e  Troubleshooting
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Managing openGear Frames in DashBoard

This section includes information for enabling DashBoard to auto-connect to openGear frames,
manually adding and re-naming frames to the Tree View, and removing frames from the Tree View.
When DashBoard is launched, frames are automatically detected and listed in the Tree Views. Refer
to the section “DashBoard Basic Tree View” for information on navigating the Basic Tree View.
For information on using the Advanced Tree View, refer to the section “Using Custom Folders in
the Advanced Tree View”.

Adding openGear Frames to DashBoard

The DashBoard Control System auto-detects any openGear frame on the same IP subnet, and queries
the network for new frames every 10 seconds if the AutoConnect button is turned on from the
toolbar. Each openGear frame lists all devices within the frame, and provides status information in
the Tree View. You can also remove and disconnect an openGear frame from DashBoard.

Adding openGear Frames to DashBoard

You will need to manually add openGear frames to the Tree View when the frame is on a different
subnet from DashBoard or if the frame is offline.

Use the following procedure to manually add an openGear frame to a DashBoard Tree View:

1. Click 5% on the Tree View toolbar to open the New TCP/IP openGear Frame
Connection dialog box.

Operating Tip You can also select File = New from the main DashBoard toolbar.

2. From the New Connection dialog box, select TCP/IP openGear Frame.

3. Select Next > to open the New openGear Frame Connection dialog box.

New TCP openGear Frame Connection |Z\@@

TCP/IP openGear Frame

This wizard allaws you to create a connaction o an apsnGear Frame through TCPJTP, The wizard should be
used when your frame is not automatically detected by DashBoard.

Display Name:
P Address:
Port:

Remember Connection:

Cancel

Figure 1. New TCP openGear Frame Connection Dialog Box

4. In the text fields provided, enter the name, IP address, and port of the openGear frame you
wish to add.
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5. Click Finish to display the openGear Frame in the Tree View. Frames added to the Tree
View are also displayed in the Advanced Tree View

This completes the procedure to manually add an openGear frame to the Tree View. Repeat the
procedure for each openGear frame that you wish to add to the Tree View.

Renaming an openGear Frame in the Tree View

You can rename any manually added openGear frames in the Tree View.
Use the following procedure to rename a manually added openGear frame in the Tree View:
1. Right-click the frame you wish to rename.
2. Select & .
The Rename Frame dialog box opens.
3. Enter the new name for the frame in the text field provided.
4. Click OK.

This completes the procedure to rename a manually added openGear frame in the Tree View.

Removing openGear Frames from a Tree View

This section outlines how to remove an openGear frame from a Tree View in DashBoard. Once a

frame is removed, DashBoard no longer reports the status in the Tree View and you are no longer
able to monitor or control the affected devices. If communication with a frame is disconnected via
the Disconnect option, the status indicator remains gray until the frame is re-connected.

If the frame you are removing is in a Custom Folder, you must first delete the frame from the
Custom Folder before it can be removed from the Tree View.

Note Auto-detected openGear frames cannot be removed from DashBoard unless
the frames are offline.

Use the following procedure to remove or disconnect an openGear frame from the Tree View:
1. Toremove a manually added openGear frame from the Tree View:
e Right-click the openGear frame you wish to remove.
e Select ¥,
The selected openGear frame is removed from the Tree View.

2. To disconnect communications to an openGear frame from DashBoard:

e
e Toggle *" 1o off.

e Right-click the openGear frame you wish to disconnect.

e Seclect J:'.

e The frame status indicator is grayed out in the Tree View.

Operating Tip To re-connect to an openGear frame, right-click the frame status indicator,
then select & .

This completes the procedure to remove or disconnect an openGear frame from the Tree View.
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Configuring openGear Frames

This section outlines how to access the Frame Configuration Page to configure the network and
Simple Network Management Protocol (SNMP) settings, and upload firmware for an openGear
Frame.

Frame Configuration Page Overview

The Frame Configuration Page includes options for network configuration, uploading firmware
and configuring SNMP. Figure 2 displays an example of a Frame Configuration Page.

Frame (10.0.1.104) X AN

ieat \_J .l
y 0,0

Multi-Definition Terminal Equipment

N open archilecture frame and cards

openGear frame: network configuration network configuration upload firmware snmp configuration

Frame name:  |Frame 1

Software version:  1.10

Use DHCP:  @np O ves

1P sddress: N :
Metmask: . . D . D
Gateway: ) El . .

Time server: ) D . .

[ Save Changes 1

copyright 2006 - 2007, Ross Yideo Limited

Figure 2. Frame Configuration Page — Network Configuration Tab

Refer to your DFR-8300 series frame user manual for information on how to configure specific
settings for your openGear frame.

Important Changing TCP/IP information may lead to a loss of communication if the
settings are incorrect, DashBoard may not be able to establish
communications until the settings are corrected.

Use one of the following methods to navigate to the Frame Configuration Page for your openGear
frame:

e  Use any web browser to connect directly to the IP address for the openGear frame.

e  Open the view for the frame as outlined in the section “Navigating the Frame
Configuration Page”.
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Navigating the Frame Configuration Page

Use the following procedure to navigate the Frame Configuration Page:
1. Display the Frame Configuration Page for an openGear frame as follows:

e  From the Tree View, right-click the openGear frame you wish to open.

e Select | to open the Frame Configuration Page in the Device View Area.

Operating Tip You can also select . on the Tree View toolbar or select the frame icon
from the Tree View.

2. To update the network configuration of the selected openGear frame:
e From the Frame Configuration Page, click network configuration.
e Configure the settings as required by the frame user manual and facility network.
e Click Save Changes to save the new configuration.
3. To upload new firmware for the selected openGear frame:
e  From the Frame Configuration Page, click upload firmware.

e Follow the instructions in the section “Uploading Firmware to an openGear
Frame”.

4. To update the SNMP configuration for the selected openGear frame:
e  From the Frame Configuration Page, click snmp configuration.

e Ensure the SNMP License Key is installed for the selected openGear frame. Refer
to the openGear frame user manual for installation and configuration details.

e  Configure the SNMP settings as required.
e Click Submit.

This completes the procedure for navigating the Frame Configuration Page.

Uploading Firmware to an openGear Frame

Use the following procedure to upload new network control firmware to an openGear frame:
1.  From the Tree View, right-click the openGear frame you wish to open.
2. Select .

The Frame Configuration Page opens in the Device View Area.

3. Select the Upload Firmware tab.

4. Enter the filename, or click Browse... to select a file.

5. Click Upload Firmware to open the Upgrading dialog box.

6. Once the upload is complete, click Reboot to restart the openGear frame.
Note The openGear frame is offline for approximately 30 seconds after re-

booting.

This completes the procedure to upload new network control firmware to an openGear frame.
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Troubleshooting

This section includes information for troubleshooting connection errors from DashBoard.

Operating Tip If you are connecting directly to an openGear frame via the DashBoard
computer, ensure that you are using a network crossover cable.

Auto-Detected openGear Frames

If DashBoard cannot open a connection to an openGear frame which should be auto-detected, the
cause may be one of the following:

e  The openGear frame is turned off.

e The openGear frame is not located on the same subnet as DashBoard within the network.

Manually Added openGear Frames

If DashBoard cannot open a connection to your openGear frame after adding it to the Tree View, the
cause may be one of the following:

e The openGear frame is powered off.
e The openGear frame properties entered in DashBoard are incorrect.

e The openGear frame may be located behind a firewall on the network.
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Using the DashBoard Interface

In This Chapter

This chapter introduces you to the DashBoard interface, and how to navigate in each area.
The following topics are discussed:

e DashBoard Interface Overview

e DashBoard Basic Tree View

e Using Custom Folders in the Advanced Tree View

e  The Device View Area

e Using Layouts
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DashBoard Interface Overview

This section includes a brief summary of the DashBoard Control System interface and its
components.

DashBoard

File Yiew - Tree View Window Help

o o e SSie Tree View X Frame 4 - Slot 7 - DRA-8204

Routina Alarms
E}es Frame 1 DRA-8204 Setup

G
58 Frame 2 Card state: O OK
B8 Frame 3

8 Frame 4 Connection: O ONLINE
B4 Frame 5
B Frame &

2 Frame 7 Product Signal Channel ARate |270MHz v
rodu

B4 Frame & Hardware

B Frame 10 Channel B Rate |Auto v

e Product [DRA—8204 —‘7 Low Signal | Pass A
o =i _ - Edit permission |Unlocked w
= Supplier |Ross Video Ltd. |

Factory Defaults  Reset
Board Rev |1C
(5@ Custom Folders 1 )
[+ (5@ Up/Down Converters Serial Number |000000-000 |

(=[5 Reclockers

@ slot 5: TRA-6206 on Frame 4 Software Rev |1.11

@ slot 7: DRA-B204 on Frame 4

e 7. Saved Layouts X

Last Layout Refresh Upload Rehoot

Figure 3. DashBoard Interface Overview

1. Main DashBoard Toolbar

This area provides access to basic tasks in DashBoard, such as saving layouts, setting
preferences, and updating Dashboard software.

2. Device View

This area includes tabs for each device when you double-click a device from the Tree View. The
Device View includes product and configuration details for each card including the card and
connection status. From this view you can verify the card and connection status, update card
parameters, and view read-only information. Buttons are provided for refreshing the Device
View, uploading software or firmware, and re-booting the device. Refer to the section “Device
View” for more information.
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3. Basic Tree View

This area lists the openGear frames and the cards installed in each frame. From this tab you can
open Device Editors, enable auto connections to frames, add new connections, and delete
devices from the view. Refer to the section “DashBoard Basic Tree View” for more
information.

4. Custom Folders (Advanced Tree View)

The Custom Folders (Advanced Tree View) licensed feature enables you to create a customized
layout of folders and subfolders in a single tab. You can re-organize your devices to suit your
workflow by dragging and dropping devices from the Basic Tree View to any Custom Folder
tab. Refer to the section “Using Custom Folders in DashBoard” for more information on using
this licensed feature.

5. Saved Layouts View

This area enables you to customize and save a series of Device View tabs and the DashBoard
window size and position as a Layout. If you have the Advanced Tree View feature installed,
saving a layout also saves any open custom folders. Layouts can be recalled using the options in
the main DashBoard toolbar or from the Saved Layouts tab. Refer to the section “Using
Layouts” for more information.

Status Indicators

The color of the status indicator beside each openGear frame name, device, custom folders and
subfolders indicates the status as follows:

. . Green — This color indicates that the device is running correctly and
communicating with the frame.

. O Yellow — This color indicates a minor problem with the device.

. . Red — This color indicates that the device is offline or has a significant error
condition. For example, there is no input or reference signal from the card.

. O Gray — This color indicates an offline frame in the Tree View. If the Advanced
Tree View feature is enabled, a gray status beside a device in a custom folder indicates
that a different device is now installed in the slot. The offline status is also reflected in
the Device Tab of any open devices for that frame.

Note The Frame Status Indicator, the Custom folders and subfolders reflect the
most negative status of any detected devices.
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DashBoard Basic Tree View

This section outlines the Basic Tree View of the DashBoard Control System. If you have installed
the Advanced Tree View feature, refer to the section “Using Custom Folders in DashBoard” for
details on using this interface.

Overview

The Basic Tree View displays openGear frames in a tree structure. When you launch DashBoard, all
openGear frames within the same subnet are auto-detected. Refer to the section “Managing
openGear Frames in DashBoard” for information on adding frames to the Basic Tree View. For
information on connecting your openGear frame using a TCP/IP connection, refer to your frame user
manual or your facility IT personnel.

The Basic Tree View also displays the cards and status information of each card, installed in each
detected openGear frame. This allows you to monitor the status and control the card parameters from
a single computer. Figure 2 provides an example of a Basic Tree View.

*- B8 Frame 1 A
+- Bl Frame 2
B2 Frame 3
() slat 0: MFC-8310-N
@ st 3 UDc-gzes

[ @ Slot 5: TRA-B206]
@ slot 6: TEA-5207
@ siot 7: DRA-5204
@ slot 9: sFs-5221
+- Bl Frame 5

[T 7

Figure 4. Example of a Basic Tree View

1. Basic Tree View Toolbar

This area provides access to the following basic tasks:

e " Device Editor Button — Selecting this button enables you to edit parameters for a
selected openGear frame or device. If you select an openGear frame to edit, toggling
this button opens the Frame Configuration Page in the Device View. If you are
editing a device, selecting this button displays a new tab in the Device View.

. |E| Auto-Connect Devices Button — Toggling this button enables DashBoard to
automatically connect to devices and display information in the Basic Tree View. You
must toggle this button off before deleting any manually added devices from the Basic
Tree View. The default setting is enabled (auto-connect).

e = Add New Connection Button — Selecting this button opens the New dialog box
and enables you to manually add an openGear frame to the Basic Tree View. Use this
button to add a frame that cannot auto-connect but can be found via the network.
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e 3 Delete Button — Selecting this button enables you to delete a selected offline or
manually added frame, or device, from the Basic Tree View.

=
. 5= Group Similar Devices Button — Selecting this button enables you to group
product types together, such as openGear frames, in the Tree View. When disabled, the
devices are listed alphabetically.
2. Frame Status Indicator

A status indicator is displayed for each openGear frame detected by DashBoard. The status
indicator represents the current status of the detected devices in the openGear frame. For
example, Frame 4 in Figure 2 indicates a yellow status because the MFC-8310-N card is at a
yellow status. A plus sign next to a frame status indicator signifies that the list can be expanded
to display a list of devices installed in that frame.

3. Device Status Indicator

A status indicator is listed for each openGear device (card) in a frame. This icon includes the
card status, the slot in which it is installed in that frame, and the card product name. This
information is detected automatically. To view a card in the Device View, double-click the card
status indicator.

Navigating the Basic Tree View

Use the following procedure to navigate the Basic Tree View features:
1. To enable DashBoard to automatically connect to the listed openGear frames in the Basic
Tree View, toggle & on the Basic Tree View toolbar.
2. To edit an openGear frame:

e Select the openGear frame to edit.

e Click | on the Basic Tree View toolbar.

e Configure the frame parameters as outlined in the section “Configuring openGear
Frames in DashBoard”.

3. To add a new connection to the Basic Tree View:
e  Click 57 on the Basic Tree View toolbar.

e Add a connection by following the instructions of the New Connection Wizard and
the procedure in the section “Adding openGear Frames in DashBoard”.

4. To delete an offline openGear frame from the Basic Tree View:
e Select the openGear frame to delete from the Basic Tree View.
e Click # on the Basic Tree View toolbar.

5. To close a Basic Tree View tab:
e Right-click the Basic Tree View tab.

e Select Close.

Note Open a Basic Tree View Tab by selecting Window = Show View = Basic
Tree View.

This completes the procedure for navigating the Basic Tree View features.
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Using Custom Folders in the Advanced Tree View

The Advanced Tree View licensed feature enables you to create a customized layout of folders, each
displaying the status of select devices. Custom Folders contain a selection of openGear frames and
installed devices. This feature allows you to drag and drop devices into subfolders, enabling you to
quickly customize folders as required. All device information is automatically updated whenever
parameters or status changes occur.

Overview

This section summarizes the Advanced Tree View tabs, Custom Folders and subfolders, and the
available menu options.

Q’ *Custom Folders 1 X

O—— & IS —

=48 all Connections ¥ New Tree Yiew Tab
5§ Frame 1 % Clear This Tree View Tab
- Frame 2 :
F}Eg Frame 3 B Cpen Tree 'vjlew »
=-EE Frame 4 @Save Tree Yiew
- E§ Frame 5 5] Save Tree View As...
- Frame 6 —@
[+ ,E:Bﬂ Frame 7 @Import Tree View
- Frame & L HExport Tree Yisw

L Frame 10
= [ Custom Folders |
=) (g Up/Down Converters v Show Device List
. Slok 1: UDC-8225-W on Frame 1
@ slot 3: UDC-8225 on Frame 4
@ slot 5: UDC-8225 on Frame 6 —
@ slot 7: UDC-8225 on Frame 6
. Slok 9: UDC-8225 on Frame 10
=I-[gy Reclockers
Slok 5: TRA-8206 on Frame 4

@ Siot 7: DRAB204 on Frame 4_|

(% Mew Folder

.|

i

3 Delete Tree View

17

Figure 5. Advanced Tree View

1. Custom Folder Toolbar

Like the Basic Tree View, the Custom Folder toolbar includes the Editor, Delete and Add New
Connection buttons. In addition, there are now buttons for creating new sub-folders, saving the
current tree view and accessing the extra menu options of the Custom Folders tab.

2. Custom Folders Main Directory

Each Advanced Tree View tab includes a Custom Folders directory. In this directory, you can
create and re-name subfolders to organize devices for customized views. The status indicator
represents the current status of the detected devices in the custom subfolder. If a device in the
subfolder needs attention, the status indicator shows the most critical warning level. For
example, the Custom Folders icon in Figure 5 indicates a red status because the UDC-8225-W
on Frame 1 is at a red status.
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Right-clicking a custom folder displays a dialog that includes options for creating a new
subfolder, connecting or disconnecting devices, renaming devices and removing devices from
the selected custom folder. To add devices to a Custom Folder, simply drag a device or frame
from the All Connections directory to the desired Custom Folder.

3. Custom Subfolders

A custom subfolder displays any number of devices from any openGear frame connected to
DashBoard. If a device in the subfolder needs attention, the status indicator shows the most
critical warning level. For example, the Up/Down Converters subfolder in Figure 5 indicates a
red status because the UDC-8225-W on Frame 1 is at a red status.

Right-clicking a subfolder displays a dialog that includes options for creating a new sub-
subfolder, connecting or disconnecting devices, renaming devices, and removing devices from
the selected subfolder.

4. Device Status Indicator

A status indicator is listed for each openGear card in a subfolder. This icon includes the card
status, the slot and frame in which it is installed, and the card product name. This information is
detected automatically, but you can also re-name the device as required. To view a card in the
Device View, double-click the card name.

5. Custom Folders Extra Options

Selecting the last button on the Custom Folder toolbar opens the Extra Options for the Custom

Folder.
. ¥ New Tree View Tab — This option opens a new Tree View tab in DashBoard.
e . . .
. Clear This Tree View Tab — This option closes the current Tree View and opens a

new Tree View in its place. If you have made any changes to the current Tree View,
you will be prompted to save your work.

e Open Tree View — This option enables you to select a previously saved Tree View to
open in the current session of DashBoard.

o [l save Tree View — This option saves the selected Tree View. If you have re-named
the main Custom Folder directory, the new name is now displayed. An asterisk
displays next to the Custom Folder tab name when there are unsaved changes for that
tab.

e &l Save Tree View As... — This option saves the selected Tree View under a new
filename.

T Import Tree View — This option enables you to import a Tree View from another
location or DashBoard computer.

e &1 Export Tree View — This option enables you to export a Tree View to another
location or DashBoard computer.

e [=* New Folder — This option enables you to create a new subfolder in the Tree View
tab.

e %% Show Device List — Selecting this option displays or hides the list of connected
frames and devices in the Tree View tab.

e 3 Delete Tree View — This option deletes the current custom folder directory from
DashBoard.
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Navigating the Advanced Tree View

Use the following procedure to navigate the Advanced Tree View features:

1. Ensure the Advanced Tree View software license is installed. Refer to the section
“Installing Licensed DashBoard Features” of this manual for installation details.

. . &
2. To open a new Advanced Tree View tab in DashBoard, select || on the toolbar.

Operating Tip You can also open a new Advanced Tree View tab by selecting Tree View
= New Tree View Tab.

3. To add a new subfolder to the Custom Folders directory of a Tree View Tab, use one of the
following methods:

e Right-click the Custom Folder icon, and then select %, You are prompted to enter
a name for the new subfolder.

e On the Custom Folder toolbar, click =, then select % . You are prompted to enter
a name for the new subfolder.

4. To add devices to a subfolder:
e Select the device indicator from the All Connections directory.

e Drag and drop the device status indicator to the desired subfolder.

Operating Tip You can re-organize devices in a subfolder using the drag and drop method.

e Re-name the device if required.
e Click OK.

5. To re-name a subfolder:
e Right-click the subfolder icon.
e Select Rename.
e  Enter the new name in the box.
e Click OK.

6. To clear the Tree View tab:

e On the Custom Folder toolbar, click =.

e Select

This completes the procedure for navigating the Advanced Tree View features.
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The Device View Area

This section includes a summary of the Device View Area and includes general instructions for
managing devices in DashBoard.

Overview

The Device View Area includes tabs of devices selected from the Basic Tree View. Devices are
added, as tabs, to the Device View Area by double-clicking the slot number in the Basic Tree View.
Selecting a Device Tab enables you to view the information on that device. You can organize tabs
in the Device View by dragging and dropping the tabs.

Each Device Tab is labeled with the status indicator, the name of the openGear frame, the slot
number that the device is installed in, and the device type. Figure 6 provides an example of a Device
Tab.

Frame 4 - Slok 0 - MFC-6310-N @

e DRA-8204
Card state: @ OK
Connection: @ ONLINE

Channel & Rate 270 MHz
Hardware Signal
Product

Channel B Rate Auto

Low Signal Pass

Product |DF"*°"8204 Edit permission Unlocked

e Supplier |R|:|ss Wideno Lid. Factory Defaults  Reset
Board Rev [1C

Serial Number |DEIDEIDEI-DEID

Software Rev [1.11

Refresh Upload Rehoot

®

Figure 6. Device Tab in Device View Area

1. Device Tab Title
This area displays the card status, openGear frame, the slot that the card is installed in, and the
product name. This information is reported automatically.

2. Hardware Status

This area displays the card status as reported by the device, and details about the connection
status.
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3. Read-Only Information

This area includes read-only information such as the status parameters as reported by the device.
The parameters and options in this area are dependant on the device selected, but can include the
product details such as software and firmware versions, hardware information and signal status.
In Figure 6, the tabs are named Product, Hardware and Signal, and include read-only
information.

4, Settings and Parameters Area

The parameters, options and tabs in this area are dependant on the device selected. Configurable
parameters depend on the device, but can include source selection, video format and timing
settings, and audio parameters.

Note All changes to device parameters are immediate.
5. Button Area
The following buttons are available in each Device Tab:
¢ Refresh — Use this button to request the latest information from the device.
o Upload — Use this button to upload new software to the device.
e Reboot — Use this button to instruct the device to reboot.
o Close — Use this button to close the Device Tab.
Navigating the Device View
Use the following procedure to navigate the Device View Area:
1. To display a Device Tab, double-click a device in the Basic Tree View.
Operating Tip You can also right-click the device and select Open, or drag and drop the

device from the Tree View to the Device View.

2. Configure settings and control parameters using the remaining tabs in the Device View. The
available tabs depends on the device and some parameters may not be configurable from
DashBoard.

3. To refresh the parameters of a device, click Refresh on the Device Tab.

4. To update the software for the device, click Upload and follow the instructions in the
section “Uploading Software to a Device”.

5. To organize the tabs in the Device View:

e Dock or undock the Tree View and Layout List from the DashBoard window by
dragging it outside the DashBoard window.

e Drag and drop the Device Tabs to organize a layout as required. For information
on saving and recalling layouts, refer to the section “Using Layouts”.

6. Close a Device Tab as follows:
e Right-click the Device Tab you wish to close.
e Select one of the following options:

e Close — Closes the selected Device Tab.
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o Close Others — Closes all other Device Tabs in the Tab Group but the
highlighted tab.

e Close All —Closes all Device Tabs in that Tab Group.

This completes the procedure to close a Device Tab in the Device View Area.
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Using Layouts

This section summarizes the Layout feature of the DashBoard interface. Information on creating,
saving, and managing layouts in the Device View is also included.

Overview

Layouts are used to save window configurations in your DashBoard interface. For example, you can
save a layout which shows a certain set of devices open in the Device View Area. You can also
determine how these Device Tabs are displayed (tabbed or tiled, or in Tab Groups), and if any
Custom Folder tabs were included.

Layouts can also save how each component of DashBoard is displayed. For example, you can save a
layout which maximizes the DashBoard window, or displays the Basic Tree View and Layout List
undocked from the Device View Area.

Each layout saves the window state, size, and position. When restoring layouts from the Layout
List, you can toggle whether to use the stored layout, or the current layout, of the open window with
the three right-hand buttons on the toolbar.

. Saved Layouks X

B X o)

Last Layauk

Figure 7. Layout List

The following buttons are available in the toolbar of the Layout List, from left to right:

. ﬁ Save Layout — Use this button to open the Save Current Layout dialog box.

e ¥ Delete the Selected Layout — Use this button to delete the currently selected layout
in the Layout List.

o [ Maintain Window State — Toggle this button to keep the DashBoard window at its
current state when restoring a layout (maximized or sized).

. lE‘ Maintain Window Size — Toggle this button to keep the DashBoard window at its
current size when restoring a layout, when not maximized.

o ™ Maintain Window Position — Toggle this button to keep the DashBoard window at
its position on the desktop when restoring a layout.
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Managing Your Layouts

Once your DashBoard window and Device Tabs are organized the way you wish, you can save this
configuration as a new Layout.

Use the following procedure to manage your layouts in the Layout List:

1.

If the Saved Layouts tab is not displayed in DashBoard:

e  From the DashBoard toolbar, select Window = Show View = Saved Layouts.
To organize Device Tabs in the Device View:

e  Click the tab you wish to move in the Device View.

e Drag and drop the tab in the Device View to the new location within the
DashBoard window.

To move a Tree View tab in the DashBoard interface:
e  Click the tab you wish to move.

e Drag and drop the tab to the new location within the DashBoard window. Black
positioning arrows display to indicate the new location.

e Undock the tab from the DashBoard window by dragging it outside the DashBoard
window. Black positioning arrows display to indicate the new location.

To restore a layout from the Layout List, double-click the name of the layout in the Layout
List.

To save the current layout:

e Click ﬂ in the Layout List to open the Save Current Layout dialog box.
e Enter a name for the new layout in the text field provided.
e Click OK.
To rename a layout in the Layout List:
e Right-click the layout in the Layout List.
e Select Rename to open the Rename Layout dialog box.
e Enter a new name for the layout in the text field provided.

e Click OK. The new name for the layout displays in the Layout List.

This completes the procedure to save a new layout to the Layout List.

Deleting a Layout

Use the following procedure to delete a layout from the Layout List:

1.
2.

In the Layout List, select the layout you wish to delete.
Click %.

The Confirm Layout Delete dialog box opens.

Click OK.

The layout is deleted from the Layout List.

This completes the procedure to delete a layout from the Layout List.
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Configuring Devices

In This Chapter

This chapter provides information on configuring devices in DashBoard.
The following topics are discussed:
e Configuring Devices in DashBoard

e Uploading Software to a Device
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Configuring Devices in DashBoard

DashBoard enables you to configure devices in real-time. Each device has specific configuration
parameters, depending on the device you have selected in the Tree View.

For example, you may wish to change a specific parameter on a device while it is online in your
openGear frame, re-configure a device, or upload new software to a device when it becomes
available.

Caution Using the Reboot button takes the card off air during the reboot cycle.

Configuring Devices in DashBoard

Use the following procedure to configure and verify device information in DashBoard:

1. From the Tree View, double-click a device to display its Device Tab in the Device View
Area.

In Figure 8, the Device View Area displays settings for the SFS-8221 located in Slot 9 of
Frame 4.

Frame ¢ - Slok 9 - ¢

SFS.82721 Setup Timing Ourtput Proc Amp

Card state: Q OK
Connection: © ONLINE

Product Hardware Signal AncillaryH Pass
Ancillary V¥ Pass

Product [5F5-6221 QABLLIES00R 20

) - Loss of Input Black
Supplier |Ross Widen Lid.

Test Pattern Disabled

Board Rev |3F

Freeze Frame

Serial Number |DDDDDD-DDD

Force Freeze Disabled

Option Board |1

Software Rev [1.26

Firmware Rey |54.1 4

Option FW Rev 36.00

Refresh Upload Reboot

Figure 8. Device Tab Example

2. Configure the required parameters using the controls provided in the Settings Area. Refer
to your manual for your device for information on available parameters and menus.

Note For each button press, a Confirm dialog box opens. Click Yes to confirm
changes, or No to abandon changes.

This completes the procedure for configuring and verifying device information in DashBoard.
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Troubleshooting

If you are unable to make changes to the parameters of a device, or the Upload or Reboot buttons
are disabled, verify that any edit permissions for the device are disabled in the Device Tab. Note that
not all openGear devices support the edit permissions feature and it is recommended that you refer to
the user manual for your device for details. This control typically appears on the Setup page of the
Device View.

Removing Offline Devices

An offline device is still listed in the Tree View, with a grayed out status indicator, however
DashBoard no longer communicates with the device. You can remove all offline devices within an
openGear frame from the Tree View using the following procedure.

Use the following procedure to remove all offline devices in an openGear frame:
1. Inthe Tree View, right-click the frame which has the offline device.
2. Select Remove offline devices.

The offline device is removed from the Tree View.

Operating Tip You can also select the device and click % to remove it from the Tree
View.

This completes the procedure to remove all offline devices in an openGear frame.
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Uploading Software to a Device

DashBoard enables you to upload software updates to devices listed for each openGear frame in the
Tree View. Refer to the user manual for your openGear device for details on uploading software to
your specific device.

Uploading Software to a Device

Use the following procedure to upload software to a device:

1.
2.
3.

Important

Select the Device Tab for the device you wish to update.

In the Device Tab, select Upload to open the Select File for upload dialog box.
Navigate to the directory where the upload file is stored, and select the file to upload.
DashBoard automatically selects the last directory that you loaded from.

Select Open.

DashBoard reads the file and opens a Confirmation dialog box. This dialog box displays
the selected upload file name, type, size, and the file creation date.

From the Confirmation dialog box, select one of the following:

e Cancel — Select this option to cancel the upload of the file and return to the
Device View.

e Continue— Select this option to upload the file. While uploading, an Uploading
Progress dialog box opens.

Pressing the Cancel button while uploading will leave the card in an
invalid state. Do not click Cancel unless the uploading progress has
stopped completely for 60 seconds or more.

This completes the procedure to upload software to a device.

Troubleshooting the Software Upload Process

Use the following information if the software upload process has failed:

If the “Selected file does not exist” or “Selected file is not a valid upload file” error
conditions are displayed in the Upload Failed dialog box, select OK from the dialog box
and re-start the upload process and select the correct file.

If a “No response from device” condition is encountered, the upload failed while in
progress due to loss of power or communications. Verify that the card is powered up and
that you have communication to the openGear frame. You must then restart the upload
process.
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DashBoard Software Updates

In This Chapter

In order to maintain your installation of DashBoard, you will be periodically required to perform
Software Updates. These updates can be scheduled automatically, or performed as needed.

DashBoard software version and feature information details are displayed in the About DashBoard
dialog box. From the About DashBoard dialog box, you can access feature, plug-in, and
configuration details, as well as view version and platform information. You can access the About
DashBoard dialog box from the Help menu.

The following topics are discussed:
e Enabling Automatic DashBoard Updates
e Updating DashBoard Features
e Managing the DashBoard Configuration
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Enabling Automatic DashBoard Updates

You can configure DashBoard to perform automatic updates at regular intervals, and inform you of
new features or updates to software that can be downloaded and installed on your computer.

Use the following procedure to enable automatic DashBoard software updates:
1.  From the main DashBoard toolbar, select Window => Preferences...
The Preferences dialog box opens.
2. Expand the Install/Update node.
3. Select Automatic Updates.
The Automatic Updates dialog box opens.

Preferences |:| |E‘ El

Automatic Updates e

=~ Installfpdate
Autornatic Updates
Licensed Features

Autamatically find new updates and notify me

Update Schedule
() Look For updates each time platfarm is started

(%) Look for updates on the Following schedule:

| ab [ 1:00 4M L

Download Options
(%) Search For updates and notify me when they are available

(O Dowrload new updates automatically and notify me when ready ko install them

[Restore DeFauIts] [ Apply ]

Figure 9. Automatic Updates Dialog Box

4. Select the Automatically find new updates and notify me check box.

5. Inthe Update Schedule section, select a schedule that best fits your production
environment, using the fields provided. For example, you can choose to look for updates
every Tuesday at 1:00 AM.

6. Inthe Download Options section, select a method for downloading and installing new
features or updates.

7. Click Apply.

Operating Tip Clicking Restore Defaults disables Automatic Updates.

8. Click OK.

This completes the procedure to enable automatic updates.
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Updating DashBoard Features

The following sections provide instructions for updating DashBoard software and installing new
features when they become available.

Software Updates can be manually performed from the Help menu. The following options are

available:
o % Find and Install — This option enables you to find and install new features and updates
using the Install/Update Wizard.
o« B Manage Configuration — This option provides an interface to view installation and

feature history, show activities in the current configuration, and add extension locations.
For information on this option, refer to the section “Managing Your Configuration” of
this manual.

Updating Installed Features with the Install/Update Wizard

Use the following procedure to update your DashBoard software using the Install/Update Wizard:
1. From the Help menu, select Software Updates = Find and Install.
The Install/Update dialog box opens.
2. Select Search for updates of the currently installed features.
3. Click Finish.

The Update Manager progress bar opens. If there are no updates to install, a dialog box
opens prompting you to click OK.

In the Updates dialog box, select the software updates you wish to install.
Click Next >.
In the Install dialog box, read the provided end-user license agreement.

Click Next >.

® =N Nk

In the list provided, ensure that the selected components will be installed in the correct
location. If you need to change the directory, click Change location and enter a new path
for the files.

9. Click Finish.
The Update Manager progress bar opens.

10. In the Verification dialog box, click Install, or Install All to begin installing the software
updates.

11. Click Yes to re-start DashBoard once installation is complete.

This completes the procedure to update your DashBoard software using the Install/Update Wizard.
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Finding and Installing New DashBoard Features

This section outlines how to use DashBoard to find and install new features without using the
Install/Update Wizard.

Use the following procedure to find and install new DashBoard features:
1. From the Help menu, select Software Updates = Find and Install.
The Install/Update dialog box opens.
2. Select Search for new features to install.
3. Click Next >.

4. Ifrequired, configure new update sites for DashBoard to search by following the procedure
“Selecting Sites for DashBoard Updates”.

Click Finish.

In the Updates dialog box, select the software updates you wish to install.
Click Next >.

In the Install dialog box, read the provided end-user license agreement.

Click Next >.

o © =N W

10. Ensure that the selected components will be installed in the correct directory. If you need to
change the directory, click Change location and enter a new path for the files.

11. Click Finish.
The Update Manager progress bar opens.

12. In the Verification dialog box, click Install, or Install All to begin installing the software
updates.

13. Click Yes to re-start DashBoard once installation is complete.

This completes the procedure to find and install new DashBoard features.

Selecting Sites for DashBoard Updates

DashBoard can be configured to search specific remote, local, and archived sites for feature updates.
This enables a user to specify locations, such as folders on the facility network or new websites, to
search for software updates or new features. The flexibility to import and export sites from other
computers on the subnet enables users to share update locations between computers.

Use the following procedure to select sites for DashBoard updates:
1. From the Help menu, select Software Updates = Find and Install.
The Install/Update dialog box opens.
2. Select Search for new features to install.

3. Click Next >.
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4. Select the site to include in the search for new features, or add a new site as follows:

e New Remote Site... — Select this option to add a new website address, other
than the default, for DashBoard to search for new features and updates. Follow the
instructions in the New Update Site dialog box.

e New Local Site... — Select this option to enable DashBoard to search a folder on
your computer for new features and updates. Follow the instructions in the Browse
for New Folder dialog box.

o New Archived Site... — Select this option to enable DashBoard to search a local
archive folder located on your computer. This archive folder includes any
previously installed updates. Follow the instructions in the Select Local Site
Archive dialog box.

o Import sites... — Select this option to enable DashBoard to import update sites
from another DashBoard computer. Importing sites from another computer allows
a user to quickly access a list of update sites located on another computer. Follow
the instructions in the Import Sites Bookmarks dialog box.

o Export sites... — Select this option to enable DashBoard to send a list of update
sites to another DashBoard computer. Follow the instructions in the Export Sites
Bookmarks dialog box.

5. Click OK.

This completes the procedure for selecting sites for DashBoard updates.
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Managing the DashBoard Configuration

Caution Use caution when enabling or disabling software features and updates, as
some components may prevent DashBoard from functioning properly.
Contact Ross Video Technical Support if you are unsure about a specific
feature or update.

Each component of DashBoard can also be managed from the Product Configuration Tool. Select
a component in the left-hand window to view properties of a component, and tasks you can perform,
such as enabling or disabling features. For example, you can select C:\Program Files\DashBoard,
and then select Show Properties to display information about your DashBoard installation.

Navigating the Product Configuration Tool

You can install updates, view your installation history, show activities in DashBoard, and add
extension locations to DashBoard using the Product Configuration Tool.

Use the following procedure to navigate the Product Configuration Tool:
1. From the toolbar, select Help = Software Updates = Manage Configuration.

The Product Configuration Tool opens.

5% Product Configuration

File
o =R B | G
= ®# DashBoard DashBoard

%5 C:\Program Files\DashEBoard
%= CiiProgram Files\DashBaardiexty This is the description of the current configuration,

Available Tasks
Scan for Updates

Search for updates For all the installed Features,
Wigw Installation History

Wigw all activities since the installation of the product,
Show Activities

Wigw the activities that caused the creation of this configuration,
Add an Extension Location

Locate and add an extension location to the current configuration.
An extension location conkains Features and plugins previously
3 Y installed.

DashBoard

Figure 10. Product Configuration Tool — DashBoard Configuration View

2. In the Product Configuration Window, select the DashBoard configuration to open the
DashBoard Configuration view. Refer to Figure 10 for an example.
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3. Select a task as follows:

e Scan for Updates — Select this option to search for feature updates. When
updates are found, the Install/Update Wizard launches. Refer to the procedure
“Updating Software with the Install/Update Wizard” for more information.

e View Installation History — Select this option to review all software update and
feature installations. Should DashBoard not function properly after a software
update has been performed, refer to this information for troubleshooting. A web
browser window opens which lists the installation history of your DashBoard
install in ascending order.

e Show Activities — Select this option to view the installation activities for your
DashBoard computer. This information is read-only and there are no configurable
options available.

e Add an Extension Location — Select this option to find a new extension
location. Select this option only if advised by Ross Video Technical Support.

4. In the Product Configuration Window, select an Install Location to open the Install
Location view. Refer to Figure 11 for an example.

%% Product Configuration

File:
%[ =] P > B @
= 8§ DashBoard . .
hall C:\Program Files|DashBoard C'\prOQram Flles\DashBoard
%, C:\Program Files\DashBoard)gxt

Install Location

Available Tasks
Disable

‘fou can enable or disable an entire install location. Disabling a
location is equivalent to disabling esery Feature init.

add an Extension Location

Locate and add an extension location to the current configuration,
An extension location contains features and plugins previously
installed.

Showe Properties

¢ 1 (e ‘Wiew the properties of the install location.

C:\Program FilesiDashBoard

Figure 11. Product Configuration Tool — Install Location View

5. Select a task as follows:

e Disable — Select this option to enable or disable a DashBoard installation. Select
this option only if advised by Ross Video Technical Support.

e Add an Extension Location — Select this option to find a new extension
location. Select this option only if advised by Ross Video Technical Support.

e Show Properties — Select this option to display a summary of the installation
details for the selected DashBoard installation. This information is read-only.

This completes the procedure for navigating the Product Configuration Tool.
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Contact Us

Contact our friendly and professional support representatives for the following:

e Name and address of your local dealer
e  Product information and pricing
e  Technical support

e  Upcoming trade show information

General Business Office 613 * 652 o 4886

and Technical Support
PHONE
After-hours Support 613 ¢ 349 ¢ 0006
Fax 613 @ 652 @ 4425
General Information solutions@rossvideo.com
E-MAIL @
Technical Support techsupport@rossvideo.com
8 John Street,
Ross Video Limited Iroquois, Ontario, Canada
POSTAL KOE 1KO0
SERVICE P.O. Box 880,
Ross Video Incorporated Ogdensburg, New York, USA
13669-0880

Visit Us

Please visit us at our website for:

e Company information

e Related products and full product lines
e On-line catalog

e Trade show information

e News

e  Testimonials
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